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software on multiple LG 3860s. 

1.2 Operating Precautions 

1.

dev

INT DUCTION 
Thank you for purchasing this LEADER instrument. To use this instrument safely, read this 
instruction manual thoroughly, and make sure that you know how to use the instrument 
properly. 

If some point about the operation of this instrument is still unclear after you have read this 
instruction manual, refer to the contact information on the back cover of the manual to contact 
LEADER, or contact your local LEADER agent. 
After you have finished reading this manual, keep it in a convenient place so that you can refer 
to it when necessary. 

About Licenses 

This software can only be used after its license key has been activated. After you have 
in led this software on a PC, connect the PC to an LG 3860, and then enter the license key 
from the PC. For details on installing the software and entering the license key, see the LG 
3860 instruction manual. 

The license key for this software can only be used on one LG 3860. You cannot install this 

 

2.1 About Turning the Power Off 

When a PC and an LG 3860 are connected by a USB cable and you want to turn the 
ices off, be sure to turn the LG 3860 off before you turn the PC off. 

 
1.2. Ab

.2.3 About Transport Stream File Playback 

If you play back a transport stream file from a PC that is handling an excessive load, the 
video or audio may be interrupted. 
See section 6.3, “Transport Stream File.” 

 
1.2.4 About the USB Connection 

While the program is being transferred from the PC to the LG 3860, do not disconnect the 
USB connection between the PC and the LG 3860. If a disconnection of the USB cable or 
other problem causes the program transfer to be interrupted, transfer the program to the 
LG 3860 again. 

 
If, while the LG 3860 is being controlled from a PC, the USB connection is mistakenly 
disconnected, an error message is displayed on the PC screen. If this happens, re-connect 
the USB connection, and then click the play button on the control application to begin 
transmitting the signal again. 

2 out the PC Setting 

When you are controlling the LG 3860 from a PC, do not set the PC to power saving mode. 
 
1
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1.3 Trademarks 

The company and product names in this document are trademarks or registered tradema
of their respective holders. 



2. SPECIFICATIONS 

2. SPECIFICATIONS 
2.1 

an be used to transfer broadcast systems to the 
LG 3860 and control the LG 3860 from a PC. After a broadcast system has been transferred 
to the LG 3860, the LG 3860 can be used as an ISDB-S signal generator. 

 
2.2 Features 

• USB 2.0 

Connect the LG 3860 to a PC through USB to transfer broadcast systems, play back 
user-defined transport streams, and configure transmission parameters. 

 
• Still Images 

Output two different still-image patterns seamlessly. 
 

• Audio Signals 

Select from three different audio patterns. 
 
2.3 Specifications 

2.3.1 Channel Coding Section 

Broadcasting System Satellite digital television broadcast 
ISDB-S (ARIB STD-B20) 

Transmission Parameters 
Modulation Format 8PSK, QPSK, BPSK 
Coding Rate 2/3 (8PSK), 1/2, 2/3, 3/4, 5/6, 7/8 (QPSK), 1/2 (BPSK) 
Roll-Off Factor √0.35 
Symbol Rate 28.86 Msps 

 
2.3.2 External TS Input Specifications 

Input Packet Format 188 bytes, 204 bytes 
Supported Stream MPEG-2 TS (ISO/IEC13818-1) 
Input Data Rate 0.2 to 75.0 Mbps 
Supported Format MPEG-TS, TS with TMCC (*1) 
Number of PCRs That Can Be Updated 

Up to 48 
Update Parameter PCR 

 
*1 See section 6.3, “Transport Stream File.” 

General 

This product is a software application that c

3 



2. SPECIFICATIONS 

2.3.3 RF Signal Generator 

Output Level 39 to 99 dBμV (75 Ω termination; in 1 dB steps) (*1) 
Output Channel Odd-numbered BS channels from channel 1 to channel 

Lo (950 MHz), Hi (2150 MHz) 
ndwidth 34.5 MHz 

 
uaranteed operating range. The optimal range is 59 to 99 dBμV (75 Ω termination).If 

n 

2.3.4 

Ps
Color bar, monoscope 

Fo (HDTV) 
Audio (T 400 Hz (LR), 1 kHz (L) + 400 Hz (R) (*1) 

tterns and formats may be changed. 
l and audio (tone) can be switched when the LG 3860 is connected to a 

 
2.3.5 C/N Generator 

5.0 to 30.0 dB (*1) 
R

 
*1  can be adjusted w C is connected. 

 
.3.6 PC Operatin

indows 7, Windows Vista, Windows XP SP3 
, 1.6 GHz or more 

ee space 

 
2.3.7 

gh the transferring of a broadcast system to the LG 
he LG 3860 can be used as a standalone ISDB-S 

signal generator. 
RF Signal Generator 

Output Level 39 to 99 dBμV (75 Ω termination; in 1 dB steps) 
Output Channel Odd-numbered BS channels from channel 1 to channel 

23, 
Even-numbered ND channels from channel 2 to channel 
24, 
Lo (950 MHz), Hi (2150 MHz) 

23, 
Even-numbered ND channels from channel 2 to channel 
24, 

Frequency Ba

*1 This is the g
signals in the range of 39 to 58 dBμV (75 Ω termination) will be generated, we recommend that a
external attenuator be connected to the LG 3860. 

 
Internal Signal 

eudo Random Signal PN23, PN15 (*1) 
Still-Image Pattern 

rmat 1920×1080i 
one) 1 kHz (LR), 

 
* The still-image pa
*1 The pseudo random signa

PC. 

C/N Adjustment Range 
esolution 0.1 dB 

 The C/N setting hen a P

2 g Environment 

OS W
CPU Intel (R) CoreTM 2 Duo
Memory 1 GB or more 
HDD 1 GB or more of fr
USB Port 1 USB 2.0 port 

Standalone Operation of the LG 3860 

Function Throu
3860, t

4 



2. SPECIFICATIONS 

Internal Signal 
Pseudo Ran PN23, PN15 dom Signal 

ern 
Format 1920×1080i (HDTV) 
Audio (Tone) 

Presets 
Recall/Store 

the 7-segment display 

 

 
.3.8 Control Application 

Controls the LG 3860 from a PC over a USB connection 

r 
 can be 

Output Control Modulation, carrier 
Ou

Even-numbered ND channels from channel 2 to channel 
24, 
Lo (950 MHz), Hi (2150 MHz) 

t  
Format 1920×1080i (HDTV) 

1 kHz (LR), 400 Hz (LR), 1 kHz (L) + 400 Hz (R) 
Generator 

 Adjustment Range ned on and off) 
 Stream File Operations 

Recall/Store Stores and recalls presets 
e beginning and ending preset numbers on the 

LG 3860 
ve 

Alarm Display 
 
2.3.9 

Li
 

* The license key for this software c ly be used on one LG 3860. 

Still-Image Patt Color bar, monoscope 

1 kHz (LR), 400 Hz (LR), 1 kHz (L) + 400 Hz (R) 

Stores and recalls presets (*1) 
Alarm Display Shown on 

 
*1 If a preset recall range has been set through the use of the control application, presets from within

that range are recalled. 

2

Function 
Broadcasting System ISDB-S 
RF Signal Generato

Output Level 39 to 99 dBμV (75 Ω termination; in 1 dB steps;
turned on and off) 

tput Channel Odd-numbered BS channels from channel 1 to channel 
23, 

Internal Signal 
Pseudo Random Signal PN23, PN15 
S ill-Image Pattern Color bar, monoscope

Audio (Tone) 
C/N 

C/N 5.0 to 30.0 dB (in 0.1 dB steps; can be tur
Transport

Select, playback, stop, etc. 
Presets 

Begin/End Sets th

Load/Sa Collectively saves and writes 40 presets 
Can't connect to USB device, etc. 

Licenses 

cense Activation When the program is transferred to the LG 3860 

an on

5 
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2.3.10 ications 

En G 3860 
C .................................. 1 

1 

 

General Specif

vironmental Conditions Same as the L
ontents License key (A4 sheet)

CD-ROM........................................................
Instruction manual ......................................... 1 



3. INSTALLATION 

3. INSTALLATION 
To u proced 0 instruction 
man

 
1. Install the encoding software. 

Install the encoding software on your PC from the CD-ROM. 
To update the encoding software, uninstall the old version, and then install the new version. 

 
2. Install the USB driver. 

Install the USB driver on your PC. 
This software supports Microsoft Windows XP SP3, Windows Vista, and Windows 7. 
Follow the procedure below to install the USB driver on these operating systems. 

 
The installation procedure explained here is for Windows XP SP3. Depending on your PC, 
your screens may differ slightly from the screen captures shown in this procedure, but the 
procedure remains the same. 

 
a) Turn on the LG 3860. 

b) Use a USB cable to connect the LG 3860 rear-panel USB port to a USB port on your PC. 

Do not connect devices other than the LG 3860 to the other USB ports on your PC. 
 

c) If the Windows Update connection window appears, select “No, not this time,” and 
click Next. 

se this software, follow the ure below. For details, see the LG 386
ual. 

 

Figure 3-1  Windows Update connection window 
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3. INSTALLATION 

d) When the installation window appears, select “Install from a list or specific location,” 
and click Next. 

 

Figure 3-2  Installation window 
 

e) When the following screen appears, select “Search for the best driver in these 
locations,” and click Browse. 

 

Figure 3-3  Driver search window 

8 



3. INSTALLATION 

f) Select the wxp folder of the encoding software that was installed during step 1, 
“Install the encoding software,” and then click OK. 

On Windows Vista or Windows 7, select the wlh folder. 
 

 

Figure 3-4  

When you click Next, the PC searches for and installs the driver. This process may 
take some time. 

 

Browse For Folder dialog box 
 

g) Check that the full path displayed here is the folder that you selected in step f, and 
then click Next. 

 

Figure 3-5  Driver folder confirmation window 
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3. INSTALLATION 

10 

e h) If any warnings that are related to the hardware installation appear, click Continu
Anyway. 

This dialog box may not appear. 
 

 

Figure 3-6  Hardware installation warning dialog box 
 

i) W allation is complete. Click Finish. hen the following window appears, the inst

 

Figure 3-7  Installation complete window 
 

3. Activate the license and transfer the program to the LG 3860. 

Connect the LG 3860 to your PC, and activate the license. 
After the license has been activated, you can use the LG 3860 a  a standalone ISDB-S 
signal gen
See section 5.3.5, “LG 3860” and chapter 4, “STANDALONE OPERATION OF THE LG 3860.” 

 
The LG 3860 can be controlled from a PC. By controlling the LG 3860 from a PC, you can play 
back external TS files and configure detailed settings that are used during LG 3860 standalone 
operation. 
Use the application software LG 3860SER01 ISDB-S Remote Control to control the LG 3860. In 
this manual, this software is referred to as the “control application.” 
See chapter 5, “CONTROL APPLICATION.” 

s
erator. 



4. STANDALONE OPERATION OF THE LG 3860 

4. STA D
This chapter will explain how to operate the LG 3860 as a standalone device. To operate the LG 
3860 in t t the PC to the LG 3860 and transfer the ISDB-S 
signal generator program to the LG 3860. 
See chapter 3, “INSTALLATION.” 

 
4.1 Panel Settings 

4.1.1 PATTERN 

Press each of the front-panel PATTERN keys to play back the internal still-image patterns 
and PN signals. 
See section 5.3.2, “Pattern.” 

 
COLOR BAR: A colorbar signal is transmitted. 

N ALONE OPERATION OF THE LG 3860 

his manner, you must first connec

MONOSCOPE: A monoscope signal is transmitted. 
PN: A pseudo random signal is transmitted (PN23/PN15). 
OTHERS: Not used 

 
4.1.2 

Press the front-panel CHANNEL key to select the output channel. When the channel is 
being selected, “CH” lights, and the output channel is displayed on the 7-segment LED. 

 
Press the ▼ and ▲ keys to select the output channel. Hold down the ▼ or ▲ key to switch 
the setting quickly. 

 
The following channels can be selected: odd-numbered BS channels from channel 1 to 
channel 23 and even-numbered ND channels from channel 2 to channel 24. 
Use the BAND key to switch between BS and ND. 
See section 6.1, “Channel Table.” 

 
4.1.3 LEVEL 

Press the front-panel LEVEL key to set the output level. When the level is being set, “dBμV” 
lights, and the output level is displayed on the 7-segment LED. 

 
Press the ▼ and own the ▼ or ▲ key to switch the 
setting quick at is in the range of 39 to 99 dBμV 
(75 Ω termination) in steps of 1 dB. 

CHANNEL 

▲ keys to select the output level. Hold d
ly. You can set the output level to a value th

11 



4. STANDALONE OPERATION OF THE LG 3860 
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 the range of presets that can be recalled, you can 
hin the range that you set. 

ication to save the following values to presets. 
N Setting, and TS Setting Main Signal and Sub Signal settings 

LG 3860” and 5.4.2, “Preset No./Store/Recall.” 

egin No. within the preset recall range that you have set with the control application. 
 
.2 Settings at Power On 

W  turns d in the first preset address 
(Begin No.). It also uses  PC while 
us 0, the 
first preset address is nu

alues of this preset are shown below. 

Ta

4.1.4 STORE/RECALL 

You can save and recall 40 preset configurations (stored in preset addresses 00 to 39). For 
details, see the LG 3860 instruction manual. 
If you use the control application to set
only recall the presets wit

 
Use the control appl
The Fixed Setting, P
See sections 5.3.5, “

 
* When the LG 3860 turns on, it transmits a signal based on the settings in the preset of the address 

specified by B

4

hen the LG 3860  on, it uses the settings that are store
these settings if you disconnect the connection with the

you transfer the program to the LG 386ing the control application. Immediately after 
mber 00. 

 
The factory default v

 
ble 4-1  Factory default values of presets 

Item Factory Default 

Layer 1 Modulation TC8PSK 2/3 

Layer 1 Slots 24 

Relative TS/TS-ID: 0 0x4010 

Layer 2 Modulation TC8PSK 2/3 

Layer 2 Slots 24 

Relative TS/TS-ID: 1 0x4011 

T

Slot Alloc Forward (filled toward the front) 

ransmission Parameters 

 COLOR BAR PATTERN 

AUDIO L: 1 kHz R: 400 Hz 

CHANNEL BS channel 1 

LEVEL 70 on) dBμV (75 Ω terminati

 



5. CONTROL APPLICATION 

5. CONTROL APPLICATION 
This
you rol the LG 3860 from a PC, you must first 
tran
See 

5.1 S

• 

Us
to 
On the taskbar, click Start, All Programs, LEADER, LG 3860SER01, and then click LG 

Remote Control. 
 

 

 carry out the procedure below to 
iple LG 3860s from a single PC, run multiple 

 

• If you have previou d one o  connected LG 3860s, that LG 3860 will be 
automatically dete

• If you have not pre  on nected LG 3860s, the Connect list 
in the main window displays “Select.” Remote control does not start until you select an 
LG 3860. Select the ontrol from the list. 

 

 chapter will explain the control application LG 3860SER01 ISDB-S Remote Control that 
use to control the LG 3860 from a PC. To cont
sfer the ISDB-S signal generator program to the LG 3860 from a PC. 
chapter 3, “INSTALLATION.” 

 
tarting and Ending Remote Control 

Starting the control application 

e a USB cable to connect the PC and LG 3860, and then follow the procedure below 
start the control application. 

3860SER01 ISDB-S 

• Starting remote control 

When one LG 3860 is connected to the PC, the LG 3860 is automatically detected by the
control application when the application starts, and you can immediately control this LG 
3860. 
When more than one LG 3860 is connected to the PC,
select the LG 3860 to control. To control mult
control applications. 

Controlling the first LG 3860 

sly controlle f the
cted. 
viously controlled e of the con

serial number of the LG 3860 that you want to c

 

Figure 5-1  Main window 
 

Controlling the other LG 3860s 

For the other LG 3860s, the Connect list in the Main window will display Select again, 
and the serial numbers of LG 3860s that are not controlled will be displayed. Select the 
serial number of the LG 3860 that you want to control from the list. 

 
If all the LG 3860s are being controlled and you start another control application, the 
following error message appears: “No Connection.” If this happens, exit the control 
application. 

 
You cannot play back transport stream files with the same file name on multiple control 
applications. 

13 



5. CONTROL APPLICATION 

• During remote control 

During remote control, The LG 3860 7-segment LED displays “PC.” When the LG 3860
is in this state, you cannot perform panel operations. 

• Ending remote control 

 

 

tion on the PC to enable panel operations on the LG 3860. 
 the PC, the LG 3860 uses the settings in the 

 
5.2 Win

The plained below. 
The  
cont eferred to as the Sub window. The Sub window is 

 control application. To display the Sub window, click 

Exit the control applica
After the LG 3860 is disconnected from
preset specified by Begin No. 

dow Explanation 

 control application window is ex
 part containing the elements labeled 1 to 13 is referred to as the Main window. The part
aining the elements labeled 15 to 20 is r

not displayed when you start the  (No. 
14) in the lower right of the screen. 

 
9

1

2

3

4

15

10

21

22 2017 19

14

1823

5

6

7

11

12

13

8

16  

Figure 5-2  Window explanation 
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5. CONTROL APPLICATION 

1 Title 

The title of the control application is displayed here. As shown in the above figure, you 
can see that this is an ISDB-S application. 

 
2 Menu bar 

The menus that are used to configure various settings are displayed here. 
See section 5.3, “Menu Bar.” 

Table 5-1  List of menus 
 

Description Menu 

File Click to select the playback file or to exit the application. 

Pattern Click to select the output pattern. 

Controls Click to select the LG 3860 that you want to control or to configure file playback settings.

Preset Click to collectively store, write, and list presets. 

LG 3860 Click to perform license activation, program transfer, preset-recall-range configuration, 

and to display information about the controlled LG 3860. 

Help Click to display information about the application. 
 

3 Toolbar 

Use the controls displayed here to select the output pattern, and store and recall presets. 
See section 5.4, “Toolbar.” 

 
4 Connect 

Select the serial number of the LG 3860 that you want to control. If no LG 3860 is 
selected, “Select” is displayed. 
See section 5.5.1, “Connect.” 

 
5 File 

The selected file is displayed here. You can also enter the full path directly. 
See section 5.5.2, “File.” 

 
6 Playback slider 

The playback status of the selected file is displayed here. You can skip parts of the file by 
moving the slider. 
See section 5.5.3, “Loop/Slider/Time.” 

 
7 Play button 

Starts the playback of the selected file. During file playback, this button switches to the 
pause button. You can operate the play button when a transport stream file has been 
selected. 
See section 5.5.4, “Play

 
8 Stop button 

Stops the playback of the selected file. You can operate the stop button when a transport 
stream file has been selected. 
See section 5.5.4, “Play/Pause/Stop.” 

/Pause/Stop.” 

15 



5. CONTROL APPLICATION 

9 Alarm button 

n you solve the problem, this button 

 
10 

settings for the selected file. The settings that you can 
 on the selected file. 

 
11 File 

C ele lso enter the full path in the text box directly or 
d ile
See section 5.

 
12 L n

Click to set d file. 
Y n ope  file has been selected. 

5.3, “Loop/Slider/Time.” 
 

13 

ack time and total playback time are displayed here. 
5.3, “Loop/Slider/Time.” 

 
14 

. 
 

15 Band 

channel band from BS and ND when you are configuring the output channel. 

 
16 Channel 

 
17 

ff. 
, “RF.” 

 
18 

tput level. 

This is displayed when any problem, such as an improper USB disconnection, occurs. 
Click this button to display a message. Whe
disappears. 

Detailed Setting 

Click to configure various 
configure differ depending
See section 5.5.5, “Detailed Setting.” 

button 

lick to s ct the playback file. You can a
rag the f  to the control application window. 

5.2, “File.” 

oop butto  

the loop mode (repeat or only once) for the selecte
ou ca rate the loop button when a transport stream

See section 5.

Time 

The selected file's playb
See section 5.

Sub-window show/hide button 

Shows or hides the sub window

Select the 
See section 5.6.1, “Band.“ 

Select the output channel. 
See section 5.6.2, “Channel.” 

RF 

Turn signal output on or o
See section 5.6.3

Level 

Set the ou
See section 5.6.4, “Level.” 

 
19 Level slider 

Move the slider to set the output level. 
See section 5.6.4, “Level.” 

16 



5. CONTROL APPLICATION 

20 Output 

Set the output signal to modulation or carrier. 
See section 5.6.7, “Output.” 

Noise 
 

21 

f. 

 
22 C/N 

Set the C/N. 
, “C/N.” 

 
23 

the C/N. 
See section 5.6.6, “C/N.” 

 
5.3 Men

5.3.1 Fi

Click the File menu to select the playback file or to exit the application. 
 

Turn noise on or of
See section 5.6.5, “Noise.” 

See section 5.6.6

C/N slider 

Move the slider to set 

u Bar 

le 

 

Figure 5-3  File menu 
 

• 

le dialog box. Select the playback file in this dialog box. 
cted file is immediately played back. 

 

Open 

Displays the Open Fi
The sele

 

Figure 5-4  Open File dialog box 

17 



5. CONTROL APPLICATION 

You can select a transport stream file or pattern file in the Open File dialog box. The 
igure above. You cannot play back pattern 

an also enter the full path in the File text box on the Main window to select a file. 
.” 

 
• 

You can also exit the application by clicking the Close button in 
ght of the window. 

 
.3.2 Pa

rn menu to select the output pattern. The selected pattern is immediately 
pl

 
You can also select the output pattern from the toolbar. 

, “Pattern Buttons.” 

four available pattern files are shown in the f
files that you create. 

 
You c
See section 5.5.2, “File

Exit 

Exits the application. 
the upper ri

5 ttern 

Click the Patte
ayed back. 

See section 5.4.1
 

 

F  

• Monoscope 

ck. 

igure 5-5  Pattern menu
 

• Colorbar 

A colorbar (simple animation) signal A monoscope signal is played ba
is played back. 

 

  
 

• PN23 

A pseudo random signal (PN23) is played back. 
 

• PN15 

A pseudo random signal (PN15) is played back. 
 

• TS 

The previously sele  back. If no transport stream file 
has been selected, the Open File dialog box is displayed. Use this dialog box to select 
the file that you want to play back. 

cted transport stream file is played

18 



5. CONTROL APPLICATION 

5.3.3 Con

Clic
play
You

 

trols 

k the Controls menu to select the LG 3860 that you want to control or to configure file 
back settings. 
 can select the file playback commands when a transport stream file has been selected. 

 

Figure 5-6  Controls menu 

Select the serial number of the LG 3860 that you want to control. A check mark is 
displayed next to the selected LG 3860. 
You can also select the LG 3860 to connect to from the Connect list on the Main 
window. 
See section 5.5.1, “Connect.” 

 
• Loop 

Click to set the loop mode to Repeat or Only once for the selected file. 
You can also click the loop button on the Main window to set the loop mode. 
See section 5.5.3, “Loop/Sli

. Durin

You can also click the play button on the Main window to play back the selected file. 
See section 5.5.4, “Play/Pause/Stop.” 

 
• Pause 

Pauses the playback of the selected file. While the playback is paused, this command 
does not appear. 
You can also click the pause button on the Main window to pause the playback of the 

ile. 

n also click the stop button on the Main window to stop the playback of the 

 
• Connect 

der/Time.” 
 

• Play 

Starts the playback of the selected file g playback, this command does not 
appear. 

selected f
See section 5.5.4, “Play/Pause/Stop.” 

 
• Stop 

Stops the playback of the selected file. 
You ca
selected file. 
See section 5.5.4, “Play/Pause/Stop.” 
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5. CONTROL APPLICATION 

• Timer 

If a transport stream file has been selected, TS playback begins when the specified 
time and the time on the PC match. If the TS is already being played back, it is 

To enable this setting, select the TS Start Time check box, and then enter the time that 
you want to start playback. You can specify a time from 00:00:00 to 23:59:59. 

 

stopped and restarted. 

 

Figure 5-7  TS playback start time setup dialog box 
 
5.3.4 

Clic ite, or list presets. 
Whi . 
For ation of presets, see the LG 3860 instruction manual. 

 

Preset 

k the Preset menu to collectively store, wr
le a transport stream file is being played back, you cannot select these commands
an explan

 

Figure 5-8  Preset menu 
 

• 

store presets 00 to 39 together in a single file. Set the filename and save 

 

Save 

You can 
location in the Save File dialog box, and then click Save. 

 

Figure 5-9  Save File dialog box 
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5. CONTROL APPLICATION 

• Load 

Click to load a preset data file (presets 00 to 39) that was previously saved through th
Save command to the LG 3860 that you are controlling. Select the file in the Ope
dialog box, and then clic

e 
n File 

k Open. 
Note that any existing presets on the LG 3860 that you are controlling will be 
overwritten. 

 

 

Figure 5-10  Open File dialog box 
 

• Information 

Displays a list of presets (00 to 39) that have been saved through the Save menu. 
Select the file in the Open File dialog box, and then click Open. 

 

 

Figure 5-11  Preset selection dialog box 
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5. CONTROL APPLICATION 

The Information window appears. 

ange the file to display in the list. 
 

In this window, you can double-click items to change the preset settings. 
After changing the settings, on the File menu, click Save to save the changes. 
Click Open in the File menu to ch

 

Figure 5-12  Information window 
 
5.3.5 LG 3860 

Click the LG 3860 menu t transfer, preset-recall-range 
 display information about the controlled LG 3860. 

 

o perform license activation, program 
configuration, and to

 

Figure 5-13  LG 3860 menu 
 

• License 

Click to activate your license key. To use the features of this product, you must first 
activate the license key. For details, see the LG 3860 instruction manual. 
If the license key has already been activated on the LG 3860 that you are controlling, 
you cannot select this command. 

 

 

Figure 5-14  Input License dialog box 

22 



5. CONTROL APPLICATION 

• 

 the program 

u are controlling, 
you cannot select this command.) 

 
To begin transferring the program, click Execute in the Transfer Program dialog box. If 
your PC is connected to multiple LG 3860s, be sure that you have selected the LG 
3860 that you want to transfer the program to from the Connect list on the Main 
window before you begin the program transfer. 

 

Transfer Program 

Click to transfer the program to the LG 3860 that you are controlling. After
transfer is complete, you can use the LG 3860 as an ISDB-S signal generator. 
(If the program has already been transferred to the LG 3860 that yo

 

Figure 5-15  Transfer Program dialog box 
 

ect the USB cable. 
If a disconnection of the USB cable or other problem causes the program transfer to 
be interrupted, transfer the program to the LG 3860 again. It takes about 10 minutes to 
transfer the program. 

 

During the program transfer, do not turn the LG 3860 off or disconn

 

Figure 5-16  Dialog box while the program is being transferred 
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5. CONTROL APPLICATION 

• Config 

Set the preset recall range for when you operate the LG 3860 by itself. Enter the 
beginning and ending preset numbers in the Config dialog box, and then click OK. The 

 
 than the specified Begin No. value. If you 

 
 

call all presets (preset numbers 0 to 
39). 

 

factory default beginning and ending preset numbers are 0 and 39 respectively. 

Specify an End No. value that is larger
specify a preset number that is outside of the range, the following error message 
appears: “Preset Begin/End Input Error.” Enter an appropriate number. 

The settings made here are invalid when you use the control application to recall
presets. You can use the control application to re

 

Figure 5-17  Config dialog box 
 

• Information 

 

 

Figure 5-18  Information dialog box 

Click to display the information of the LG 3860 that you are controlling. 
While a transport stream file is being played back, you cannot select this command. 

MAC address

Serial number

Transfer status of the program (SER01 is displayed if the
program has already been transferred to the LG 3860.)

License key activation status (PASS is displayed if the
license key has been activated.) 

Firmware version

Pattern version
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5. CONTROL APPLICATION 

5.3.6 

Clic
 

Help 

k the Help menu to display the information about the application. 

 

Figure 5-19  Help menu 

About LG 3860SER01 

Click 

 
• 

this to display a dialog box that contains information about the application, such 
as its version. 

 

 

Figure 5-20  About LG 3860SER01 dialog box 
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5. CONTROL APPLICATION 

5.4 Toolbar 

5.4.1 Pattern Buttons 

Click the button that corresponds to the output pattern that you want to select. The selected 
pattern is immediately played back. 

 
You can also select the output pattern from the Pattern menu. 
See section 5.3.2, “Pattern.” 

 

 

Figure 5-21  Pattern buttons 
 

.4.2 Pres ecall 

You can use the preset toolbar to store and recall presets. 
The settings that are stored and recalled are the Pattern, Fixed Setting, PN Setting, TS 
Setting Main Signal and Sub Signal, Channel, and Level settings. 

 

5 et No./Store/R

 

Figure 5-22  Preset toolbar 
 

• Storing presets 

To store a preset, on the toolbar, enter a preset number next to Preset No., and then 
click Store. When the following confirmation message appears, click Yes to store the 

 
preset on the LG 3860. 

 

Figure 5-23  Confirmation dialog box 
 

Notes 

• You cannot store presets when you have selected a transport stream file. 
• Preset contents that are stored in the manner outlined above are retained even 

after the LG 3860 is turned off. 
 

• Recalling presets 

To recall a preset, on the toolbar, enter a preset number next to Preset No., and then 
click Recall. The preset that has been stored on the LG 3860 is recalled, and the 
settings of the selected preset are displayed in the control application. 
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5. CONTROL APPLICATION 

5.5 Main Window 

C are displayed in the list. 

5.5.1 Connect 

Select the serial number of the LG 3860 that you want to control. The serial numbers of the 
LG 3860s that are connected to the P

 

 

Figure 5-24  Displaying the list of LG 3860s that you can control 
 

.5.2 File 

Select the 
In a
See 

• Click the file button 

5

file to play back. Use one of the following three methods to select the file. 
ddition to the methods listed here, you can also click the File menu to select the file. 
section 5.3.1, “File.” 

 

  
Click the file button, and then select the file from the Open File dialog box that appears. 
The selected file is immediately played back. 

 
attern file in the Open File dialog box. The 

ailable pattern files are shown below. You cannot play back pattern files that 

 
• Ent ext box 

 the full path to the file in the text box in the Main window. 

 
• 

You can play back a file by dragging it to the control application window. However, you 
cannot drag files from the Open File dialog box. 

You can select a transport stream file or p
four av
you create. 
Colorbar, Monoscope, PN23, PN15 

er the full path directly into the t

You can directly enter
If the file specified by the full path that you entered can be played back, it is played 
back immediately. 

Drag a file to the application 
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5. CONTROL APPLICATION 

5.5.3 Loop/Slider/Time 

Use these elem
 

ents to configure file playback settings. 

ted file. 
You can use the following loop buttons when a transport stream file has been selected. 

 

• Loop 

Click to set the loop mode (repeat or only once) for the selec

 Repeat 

 
 Only once 

 
• Slider 

The playback status of the selected file is displayed here. You can skip parts of the file 
by moving the slider. 

 
• Time 

The selected file's playback time and total playback time are displayed here. 
 
5.5.4 Play/Pau

nsport stream file has been selected, click these buttons to play back the file 
nd stop the playback. 

 

on to start the playback of the selected file. 
During file playback, this button switches to the pause button. 

se/Stop 

When a tra
and pause a

• Play 

Click the play butt

 
 Play button 

 
• 

f the selected file. 
While file playback is paused, this button switches to the play button. 

 

Pause 

Click the pause button to pause the playback o

 Pause button 

 
• 

 the selected file. 
 

Stop 

Click the stop button to stop the playback of

 Stop button 
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5. CONTROL APPLICATION 

5.5.5 Detailed Setting 

Click to configure various settings for the selected file. To display the dialog box for the 
ngs, click the  selected setti button in the upper right of the window. The settings that you 
 differ depending on the selected file. 

 
can configure

 

Figure 5-25  Detailed Setting list 
 

ttern (excluding pseudo random signals) has been 
, use this dialog box to select the output audio. Click Apply to apply the 

 

• Fixed Setting 

When an internal still-image pa
selected
settings. 

 

Figure 5-26  Fixed Setting dialog box 
 

1kHz : A tone signal (left: 1 kHz and right: 400 Hz) is generated. 

Audio 

(L)+400Hz(R)
1kHz(L,R): A tone signal (left and right both 1 kHz) is generated. 

,R): A tone signal (left and right both 400 Hz) is generated. 400Hz(L
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5. CONTROL APPLICATION 

• PN Setting 

When an internal pseudo random signal has been selected, use this dialog box to 
select its polarity and it packet type. 
Click Apply to apply the settings. 

s 

 

 

Figure 5-27  PN Setting dialog box 
 

PN Polarity 

Normal: A polarity that enables error measurement on generic BER 
measuring instruments is used. 

Inverted: The inverse of the Normal polarity is used. 
 

Packet Type 

Sync + PRBS: x) + 187-bSync (47he yte PN 
Header + PRBS:  (hex) + 184-byte PN Sync (47 hex) + 1FFF (hex) + 10

 
• TS

ly to apply the settings. 

If the transmission rate (Useful Bitrate) that is based on the transmission parameters 
that you specify here will cause the selected file's rate (Source Bitrate) to overflow, the 
Useful Bitrate value will be displayed in red. In this situation, the selected file will not 
be generated correctly, so change the transmission parameters until the Useful Bitrate 
value is displayed normally (in black). 

 

 Setting 

Use this dialog box to configure transmission parameters. 
Click App

 

 

Figure 5-28  TS Setting dialog box 
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5. CONTROL APPLICATION 

• Main Signal 

Set the transmission parameters of the selected Source (Fixed Pattern, PN, or 
transport stream file). 

 

Select the modulation method. 

Modulation 

[ BPSK 1/2 / QPSK 1/2 / QPSK 2/3 / QPSK 3/4 / QPSK 5/6 / QPSK 7/8 / TC8PSK 2/3 ] 
* This depends on the TS when you have selected a TS with TMCC. 

 
Slots 

Select the number of slots. 
Because dummy slots are appended according to the modulation method, the 
minimum number of slots differs according to the modulation method. 
* This depen  TS when you have selected a TS with TMCC. ds on the

 

 pattern has been selected: 

TS-ID 

When a fixed
The TS-ID is set automatically according to the output channel. 

mber Table.” 

You can specify the TS-ID. 
ort stream file has been selected: 

t stream file. 

See section 6.2, “Channel Nu
When a PN has been selected: 

When a transp
The setting depends on the transpor

 
Slot Alloc 

Forward: The frame assignment position moves forward so that frames 
are filled toward the front. 

Backward: The frame assignment position moves backward so that frames 
are filled toward the back. 

 
TS Mode (Only when a TS with TMCC has been selected) 

Auto: Output is generated using the TMCC in the TS. 
MPEG-TS: Set the desired transmission parameters as an MPEG-TS. 

 
• Sub Signal 

If the number of Main Signal slots is less than 48, NULL packets are automatically 
inserted for the remaining slots. 

 
• TS parameters (Only valid when a transport stream file has been selected) 

TOT Overwrite 

Select this check box to overwrite the TOT (Time Offset Table) in the TS according to 
the PC time settings. [ On / Off ] 
* This setting is not valid if there is no TOT in the TS. 
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5. CONTROL APPLICATION 

PCR Update 

Select this check box to encode the TS into a TS with TMCC. Because the LG 3860 
rearranges the packet order and inserts null packets during the conversion process, 

ust be overwritten. Therefore, normally turn this setting on. [ On / Off ] the PCRs m
* This setting is not valid when you are using a TS with TMCC. 

 

 PID from the TS. 

Null Packet Filter 

Select this check box to filter any packets that have the 0x1FFF
Removing unnecessary null packets provides you with an increased number of carrier 
modulation choices. [ On / Off ] 
* This setting is not valid when you are using a TS with TMCC. 

Range (Only valid when a transport stream file has been selected) 
 

• 

meric keypad or the Select this check box to specify the playback range. Use the nu
sliders to set the Start and End times. 
If you set the range, and then select a different TS, the Range check box will be 

S file from its start to end. [ On / Off ] cleared. Clear this check box to play the T
 

* If the bit rate cannot od is set to TC8PSK, 
and the bit rate is then calculated. 

Note the following re
d bit rate and the file size. Depending on 

• The minimum tim  time setting is 
ally calculated for packets. 

n incomplete data byte exists at the start or end of the data, the LG 3860 ignores this 
ta fraction and

• The number of p n integer multiple of the minimum number 
ts of the sel
arly, when y

fractional part so  are played back is an integer multiple of 

 
• eters 

 display t u 
configured with TS Setting. 

 be calculated from the TS file, the modulation meth
the number of slots is set to 24, 

garding the TS playback range. 
• The displayed time is calculated from the detecte

the data, there may be a small degree of error in this calculation. 
e unit that you can use to specify the time is 1 second. The

automatic
• If a

da  plays data back in units of packets. 
ackets that are played back is a

of slo ected modulation method. 
Simil ou specify the playback range, the LG 3860 automatically truncates the 

 that the number of packets that
the minimum number of slots. 

Param

Select this to he TMCC information of the transmission parameters that yo

 

 

Figure 5-29  ISDB-S Parameters dialog box 
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5. CONTROL APPLICATION 
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 Mode / Slot Info. Transmission

Displays the transmission mode and its number of slots 
 

 notation 

Relative TS / TS-ID 

Displays the TS-IDs of relative TS0 to TS7 in hexadecimal
 

Relative TS / Slot Info. 

Displays the frame assignments for the relative transport streams 

 
5.6 Sub Window 

 

Figure 5-30  Sub window 
 
5.6.1 Ban

Select th  configuring the output channel. 
 
5.6.2 Channel 

Select the o hat you can select, see section 6.1, “Channel 
Table.” 

 
5.6.3 RF 

Turn signal 
 

.6.4 Level 

utput signal. 
Ente

 
.6.5 Noise 

Turn noise on or off. 
 
5.6.6 C/N 

Set the C/N. 
Enter the value in the text box, or use the slider to set the level. 

 
5.6.7 Output 

Set the output signal to modulation (MOD) or carrier (CW). 
 

d 

e channel band from BS and ND when you are

utput channel. For the channels t

output on or off. 

5

Set the level of the o
r the value in the text box, or use the slider to set the level. 

5



6. APPENDIX 

6. APPEN
6.1 Chan

The B w. 
 

Table 

ND 

DIX 
nel Table 

S and ND channel tables are shown belo

6-1  Channel table 

BS 

CH Frequency (MHz) CH Frequency (MHz)

Lo  950.000 - - 

1 1049.480 2 1613.000 

3 1087.840 4 1653.000 

5 1126.200 6 1693.000 

7 1164.560 8 1733.000 

9 1202.920 10 1773.000 

11 1241.280 12 1813.000 

13 1279.640 14 1853.000 

15 1318.000 16 1893.000 

17 1356.360 18 1933.000 

19 1394.720 20 1973.000 

21 1433.080 22 2013.000 

23 1471.440 24 2053.000 

- - Hi 2150.000 
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6. APPENDIX 

6.2 Channel Number Table 

el number tables when a fixed pattern is selected are shown below. 

Channel Number 

The BS and ND chann
 

Table 6-2  Channel number table 

-ID 
xadecimal Decimal

Service 

Provider Name 
Service Name Band Slot Assignment TS

He

Forward 0x4010 0097 151 ビーエス朝日 BS 朝日 BS-1 

B 4011 1 161 BS-TBS BS-TBS ackward 0x 00a

F 4030 191 WOWOW WOWOW プライム orward 0x 00bf BS-3 

B 4031  171 BS ジャパン BS ジャパン ackward 0x 00ab

F 4450  192 WOWOW WOWOW ライブ orward 0x 00c0BS-5 

B 4451  193 WOWOW WOWOW シネマ ackward 0x 00c1

F 4470  201 スター・チャンネル スター・チャンネル 2orward 0x 00c9BS-7 

B 4671  236 アニマックス BS アニマックス ackward 0x 00ec

F 4090  211 日本 BS 放送 BS11 orward 0x 00d3BS-9 

B 4092  222 WHC TwellV ackward 0x 00de

F 46b0  238 ビーエス FOX FOXbs238 orward 0x 00eeBS-11 

B 46b1 241 スカパーエンタ BS スカパー！ ackward 0x 00f1 

F 40d0  141 BS 日本 BS 日テレ orward 0x 008dBS-13 

B 40d1  181 BS フジ BS フジ 181 ackward 0x 00b5

Forw d 40f1  101 NHK NHK BS1 ar 0x 0065BS-15 

Backward 0x40f2 0067 103 NHK NHK BS プレミアム 

Forward 0x4310 0123 291 NHK 総合・東京 NHK 総合 1・東京 BS-17 

Backward 0x4311 0126 294 日本テレビ 日テレ 1 

Forward 0x4730 00ea 234 グリーンチャンネル グリーンチャンネル BS-19 

Backward 0x4731 00f2 242 ジェイ・スポーツ J SPORTS 1 

Forward 0x4750 00fc 252 IMAGICA IMAGICA BS BS-21 

Backward 0x4751 00f4 244 ジェイ・スポーツ J SPORTS 3 

Forward 0x4770 00fb 251 釣りビジョン BS 釣りビジョン BS-23 

Backward 0x4772 0102 258 ディズニー D-Life 

ND-2 - 0x6020 00ef 239 SPET 日本映画専門 chHD

ND-4 - 0x7040 0064 100 SPET e2 プロモ 

ND-6 - 0x7060 00dd 221 CS 映画放送 東映チャンネル 

ND-8 - 0x6080 0037 55 SC サテライト放送 ショップチャンネル 

ND-10 - 0x60A0 00e4 228 SPET ザ・シネマ 

ND-12 - 0x70c0 012f 303 シーエス・ワンテン テレ朝チャンネル 

ND-14 - 0x70e0 00fd 253 アクティブ・スポーツ J スポーツ PlusH 

ND-16 - 0x7100 0156 342 インタラクティーヴィ ヒストリーチャンネル

ND-18 - 0x7120 00f0 240 インタラクティーヴィ ムービープラス HD 

ND-20 - 0x7140 0133 307 サテライトサービス フジテレビ ONE 

ND-22 - 0x7160 00a0 160 C-TBS C-TBS ウェルカム 

ND-24 - 0x7180 012C 300 シーエス日本 日テレプラス 
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6. APPENDIX 

6.3 Transport Stream File 

With the LG 3860SER01, you can use an MPEG-TS (188 and 204 bytes) or a TS with TMCC 

ist of the 204-byte transport streams that are defined in 
ARIB-TR-B15 and the 204-byte tran at are de  ARIB STD-B20. 

 
6.3.1 i  (S-TM

The ba  inform ust erted e f es of the 1 S 
d  that foll  188  TS pa  

The tr  mod T  re CC in
 th r setting can u se tra rt s MPEG

 

as the transport stream file. 
Transport streams with TMCC cons

sport streams th fined in

TS w th TMCC CC) 

sic TMCC ation m  be ins  in th irst 8 byt 6-byte R
enco ed block ows the -byte cket.

ansmission e, slot information, and S-ID flect the TM formation. 
With e prope s, you se the nspo streams a -TS. 

 

Figure 6- MCC t 
 
6.3.2 i  (M-TM

a must rted i format positions indicated below
The transmission mode, slot TS-ID refl TMCC information. 

 

1  S-T  forma

TS w th TMCC CC) 

The TMCC dat be inse n the . 
information, and ect the 

 

Figur  M-T  fo
 
6.3.3 -TS 

s a TS that is diff m th MCC M-TMCC. 
an spec  the tra ion m nd th t in

The TS-ID reflects the PAT section. 

e 6-2 MCC rmat 

MPEG

This i erent fro e S-T and 
You c ify nsmiss ode a e slo formation. 
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n number, click About LG 3860SER01 on the control 

 

he fixed patterns for the changes in the BS digital services that 

• 
• 
• 

● Ver 1.2 

• Support has been added to the fixed patterns for the changes in the BS digital services that 
took place in  in the TS-ID/channel numbers that are 
planned for October 201

the switching that is defined in ARIB-STD-B20 when an 
S-TMCC that includes a TMCC switch is being played back. 

 

6.4 Software Revision History 

This manual was written for software version 1.3. 
To check the software versio
application's Help menu. 

● Ver 1.3 

• Support has been added to t
took place in October 2011 and for the changes in the TS-ID/channel numbers that are 
planned for April 2012. 
Output channel settings Lo (950 MHz) and Hi (2150 MHz) have been added. 
A noise addition function has been added. 
Support has been added for listing and editing presets in the preset menu. 

 

April 2011 and for the changes
1. 

• Support has been added for 



 

Following information is for Chinese RoHS only

LG 3860SER01

销售的电子信息产品,依据2006年2月28日公布的

染

可再利用。数字表示的是环境保护使

起在数

表示的年限内，产品不会产生环境污染和对人体、财产的影响。

部件名称             有毒有害物质或元素    Hazardous Substances in each Part

Parts 铅 汞 镉 六价铬 多溴联苯 多溴二苯醚

(Pb) (Hg) (Cd) (Cr(Ⅵ)) (PBB) (PBDE)

本体部 × ○ ○ ○ ○ ○

备注）

  ○：表示该有毒有害物质在该部件所有均质材料中的含量均在SJ/T11363-2006 规定的限量要求以下。 

  ×：表示该有毒有害物质或元素至少在该部件的某一均质材料中的含量超出SJ/T11363-2006 

  　　标准规定的限量要求。

Ver.1

  所

码:

含有毒有害物质信息

部件号

此标志适用于在中国

《电子信息产品污染控制管理办法》以及SJ/T11364-2006《电子信息产品污

控制标识要求》，表示该产品在使用完结后

用期限，只要遵守与本产品有关的安全和使用上的注意事项，从制造日算

字所

产品适当使用后报废的方法请遵从电子信息产品的回收、再利用相关法令。

详细请咨询各级政府主管部门。

产品中有毒有害物质或元素的名称及含量
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